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Znaki towarowe
© 2011 Plustek Inc. Wszelkie prawa zastrzezone. Reprodukcja dowolnej czesci tego
dokumentu bez zezwolenia jest zabroniona.
Wszystkie znaki towarowe i handlowe wymienione w niniejszym dokumencie stanowig
wiasnos¢ ich prawnych wiascicieli.

Odpowiedzialnos¢

Mimo dotozenia wszelkich staran w celu zapewnienia doktadnosci catej zawartosci
niniejszego podrecznika, niniejszym zrzekamy sie wszelkiej odpowiedzialnosci z tytutu
wszelkich btedéw, brakéw lub gwarancji poczynionych w niniejszym dokumencie,
niezaleznie od tego, czy takie biedy, braki lub gwarancje wynikajg z zaniedbania,
przypadku lub innego powodu. Tres¢ niniejszego dokumentu moze ulec zmianie bez
powiadomienia. Nasza firma nie ponosi Zadnej odpowiedzialnosci prawnej, jesli
uzytkownicy nie bedg przestrzegali instrukcji zawartych w niniejszym podreczniku.

Prawo autorskie
Skanowanie niektérych dokumentéw, takich jak, miedzy innymi, czeki, banknoty,
dokumenty tozsamosci, obligacje rzadowe lub dokumenty publiczne moze by¢ prawnie
zabronione oraz / lub moze stanowi¢ podstawe do wszczecia postepowania karnego.
Niniejszym zalecamy odpowiedzialne podejscie i szacunek wobec praw autorskich do
skanowanych ksigzek, czasopism, gazet oraz innych materiatow.

Informacja o ochronie sSrodowiska
Informacja dotyczaca recyklingu lub utylizacji po zakonczeniu cyklu uzytkowania
produktu, aby uzyskac¢ informacje na temat recyklingu i utylizacji, nalezy sie zwréci¢ do
lokalnych dystrybutoréw albo dostawcéw. Projektowi i wykonaniu niniejszego urzadzenia
przyswieca idea zréwnowazonej poprawy ochrony $rodowiska. Pragniemy dostarczaé
urzadzenia, ktére spetniajg wszelkie swiatowe normy w zakresie ochrony Srodowiska.
Informacje na temat prawidtowej utylizacji produktu mozna uzyska¢ u wtadz lokalnych.

Opakowanie produktu podlega recyklingowi.

Informacje na temat recyklingu (dotyczy tylko krajow Unii Europejskiej)

Chron srodowisko naturalne! Niniejszy produkt nie moze byC utylizowany razem z
odpadkami z gospodarstwa domowego. Zuzyte urzadzenie nalezy przekaza¢ do
lokalnego centrum zajmujgcego sie darmowag utylizacjg odpadow elektronicznych.

Przyktadowe stany ekranu w podreczniku
Zrzuty ekranu wykorzystane w niniejszym podreczniku odnoszg sie do systemu
operacyjnego Windows XP. W przypadku korzystania z system Windows 2000/Vista/7,
ekran bedzie nieco réznit sie od przedstawionego, ale funkcje pozostang identyczne.
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WPROWADZENIE

Dziekujemy za wybranie skanera naszej produkcji. Korzystanie z niego znacznie
poprawi profesjonalizm codziennych operacji wykonywanych za posrednictwem
komputera, umozliwiajgc wprowadzanie obrazéw i tekstu elektronicznego do systemu
komputerowego. Urzadzenie umozliwia wyjgtkowo proste skanowanie dokumentow
jednostronnych.

Podobnie jak w przypadku innych urzadzen, niniejszy skaner przeszedt
wyczerpujace testy jakosci, gdyz marka Plustek gwarantuje doskonatg niezawodnosc¢
oraz maksymalng satysfakcje klienta. Liczymy wiec, ze przy okazji kolejnych zakupéw
komputerowych siegniesz po kolejne produkty tej wysokiej jakosci marki.

SPOSOB KORZYSTANIA Z PODRECZNIKA

Niniejszy podrecznik uzytkownika zawiera instrukcje i ilustracje przedstawiajgce
sposéb instalacji i obstugi skanera. Dokument zaktada znajomos¢ sSrodowiska
Microsoft Windows 2000 Professional/ XP/ Vista/ 7. W przypadku jej braku, zaleca sie
siegniecie do podrecznika uzytkownika systemu Microsoft Windows oraz blizsze
zapoznanie sie z wymienionymi systemami operacyjnymi jeszcze przed rozpoczeciem
korzystania ze skanera.

Rozdziat ,Wprowadzenie” zawiera informacje dotyczace zawartosci pudetka z
zestawem oraz minimalne wymagania systemowe dla obstugi niniejszego skanera.
Przed rozpoczeciem procesu instalacji skanera zaleca sie sprawdzenie zawartosci
pudetka pod wzgledem kompletnosci zestawu. W przypadku braku lub uszkodzenia
dowolnego elementu zestawu nalezy skontaktowac sie ze sprzedawcg skanera lub
bezposrednio z obstugg klienta Plustek.

Rozdziat | opisuje sposob instalacji oprogramowania skanera oraz sposob
podtgczenia skanera do komputera. Uwaga: Do podigczenia skanera do komputera
stuzy ztgcze USB. Jesli dany komputer nie obstuguje technologii USB, zaleca sie
zakupienie karty interfejsu USB w celu zapewnienia obstugi USB lub zakupienie i
zainstalowanie ztgcz USB w przypadku, gdy ptyta gidwna obstuguje opcje USB.
Niniejszy podrecznik zaktada, ze komputer obstuguje technologie USB oraz posiada
wolne zigcze USB.

Rozdziat Il opisuje sposdb korzystania ze skanera.
Rozdziat Il opisuje sposob konserwacji i czyszczenia skanera.

Rozdziat IV zawiera informacje dotyczgace wsparcia technicznego, ktére
umozliwiajg usuniecie prostych problemow z urzadzeniem.

Zatgcznik A zawiera specyfikacje zakupionego skanera.

Zatgcznik B zawiera informacje dotyczace obstugi klienta, umowy o ograniczone;j
gwarancji oraz oswiadczenie o zgodnosci FCC w zakresie niniejszego produktu.
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KONWENCJE UZYTE W PODRECZNIKU

Pogrubienie — Polecenia lub zawartos¢ ekranu komputera.

WIELKIE LITERY — Wazne uwagi lub pierwsze uzycie kluczowego terminu w
rozdziale

Kursywa — Przyciski na skanerze LUB wazne uwagi.

Uwaga dotyczaca ikon

Niniejszy podrecznik uzywa ponizszych ikon w celu zwrdocenia uwagi ha
szczegolnie wazne informacje.

W celu unikniecia uszkodzenia ciata lub wypadku,
konieczne jest doktadne przestrzeganie tak oznaczonej
Ostrzezenie procedury.
Qﬁmnﬂm} Wazne instrukcje, ktérych zapamietanie pozwoli

wyeliminowaé btedy.

¥ Opcjonalne wskazdéwki utatwiajgce prace.
Informacja

éRODKI BEZPIECZENSTWA

Przed rozpoczeciem Kkorzystania z niniejszego
urzgdzenia nalezy zapozna¢ sie z ponizszymi
informacjami  w celu wyeliminowania lub

zmniejszenia ryzyka uszkodzenia ciata lub
mienia.

Ostrzezenie

1. Uzytkowanie, produkt jest przeznaczony do uzytkowania wewnatrz pomieszczenh, w
suchym otoczeniu. Wewnatrz urzadzenia moze dojs¢ do kondensacji wilgoci a w
rezultacie do awarii, w przypadku wystgpienia nastepujacych okolicznosci:

B bezposredniego przeniesienia urzadzenia z chtodnego do cieptego
pomieszczenia;
B po ogrzaniu chlodnego pomieszczenia;
B po zainstalowaniu urzadzenia w wilgotnym pomieszczeniu.
W celu unikniecia kondensacji wilgoci nalezy stosowaé sie do nastepujgcej
procedury:
i. Zamknac¢ urzgdzenie w plastikowym opakowaniu w celu umozliwienia mu
przystosowania sie do warunkdéw panujgcych w danym pomieszczeniu.
ii. Przed zdjeciem takiego opakowania ochronnego nalezy odczeka¢ 1-2 godziny.
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2. Korzysta¢ z zasilacza sieciowego i kabla USB dostarczonych w zestawie ze
skanerem. W przeciwnym razie moze doj$¢ do awarii.

3. Zasilacz sieciowy powinien by¢ fatwo dostepny na wypadek koniecznosci
szybkiego odfaczenia zasilania przy okazji wystapienia sytuacji krytycznych.

4. Uszkodzony kabel oznacza ryzyko porazenia pragdem lub pozaru. Przewdd
zasilania nalezy prowadzi¢ po prostej i wystrzega¢ sie jego wykrecania, zginania
lub Scierania.

5. W przypadku dtuzszego niekorzystania z urzadzenia — na przyktad w trakcie nocy
lub przez dtuzszy weekend, zaleca sie odtgczenie skanera od zrédta zasilania w
celu unikniecia ryzyka pozaru.

6. Nie nalezy rozmontowywac¢ skanera. W przeciwnym razie moze wystgpi¢ ryzyko
porazenia pradem, a ponadto otwarcie skanera powoduje uniewaznienie gwarancji.

7. Szyba skanera jest delikatna, dlatego tez wszelkie uderzenia lub stukniecia moga
spowodowac jej uszkodzenie.

8. Nie wystawia¢ skanera na dziatanie silnych wibracji, gdyz moze to spowodowaé
uszkodzenie elementéw wewnetrznych.

MINIMALNE WYMAGANIA SYSTEMOWE'

e Komputer PC z procesorem Intel Pentium®lil 1G lub kompatybilnym
e 256 MB RAM

e Dostepny port USB 2.0

e Naped CD-ROM lub DVD-ROM

¢ 800 MB wolnego miejsca na dysku

e Karta graficzna obstugujgca 16 bitowa jako$¢ kolorow lub wyzszg

e System operacyjny: Windows 2000 Professional, Windows XP Home
(Kompatybilnym), Windows XP Professional (Kompatybilnym), Windows Vista,
Windows 7

W celu zapewnienia optymalnej pracy urzadzenia

0 zaleca sie korzystanie z systeméw wyposazonych

w procesor Pentium® 1.8 G lub szybszy (lub

Informacja  kompatybilny), 512 MB RAM oraz 1 GB wolnego
miejsca na dysku twardym.

Tw przypadku skanowania i edycji wiekszych ilosci obrazéw zaleca sie korzystanie z
komputera PC o wyzszych specyfikacjach. Ponadto, wymagania systemowe stanowig jedynie
wartos¢ wytyczng i, najogdlniej rzecz biorgc, czym lepsza jako$¢é komputera (ptyta gtéwna,
procesor, dysk twardy, pamie¢ RAM, karta graficzna), tym lepsze wyniki pracy.



ZAWARTOSE OPAKOWANIA?

Skaner

Kabel USB x 2

Zasilacz sieciowy

Skrocona instrukcja

Ptyta CD-ROM do instalacji urzgdzenia / oprogramowania
Arkusz ustawien kalibracyjnych

Sciereczka czyszczacy

Modut podkfadki

© N o Ok Wb

2 Pudetko oraz pozostate element opakowania nalezy zachowaé na wypadek przysziego
transportu urzgdzenia.



ELEMENTY SKLADOWE SKANERA

10.

PODAJNIK ADF (AUTOMATYCZNY PODAJNIK DOKUMENTOW) — Stuzy do
automatycznego podawania stosu dokumentéw do skanowania.

PROWADNICA SZEROKOSCI PAPIERU — Stuzy do okre$lenia szerokoci
uzywanego papieru.

PRZYCISK PC2 — Nacisnij, aby nawigza¢ potaczenie skanera z komputerem 2.

PRZYCISK SCAN — Nacisniecie umozliwia wykonanie wcze$niej okreslonej
czynnosci skanowania.

PRZYCISK PDF —Wcisnij ten przycisk, aby przekonwertowa¢ dokument na plik
PDF.

DIODA ZASILANIA — Wskazuje stan skanera.

Dioda Stan

Wi Skaner jest wigczony i gotowy do rozpoczecia skanowania.

Wyt |Skaner jest wylaczony — zasilanie zostato wylgczone lub zasilacz

sieciowy nie zostat prawidtowo podtgczony do gniazdka sieciowego.

PRZYCISK CUSTOM — Nacisniecie umozliwia wykonanie wczesniej okreslonej
czynnosci skanowania.

PRZYCISK PC1 — Nacisnij, aby nawigza¢ potaczenie skanera z komputerem 1.

——FHiE
© O 117

PRZELACZNIK ZASILANIA — Stuzy do wiaczania (ON) lub wytgczania (OFF)
skanera.

—

PC1 PORT USB — Stuzy do podigczenia skanera do portu USB na komputerze 1
za pomocg kabla USB dotaczonego do zestawu.
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11. PC2 PORT USB — Stuzy do podtaczenia skanera do portu USB na komputerze 2
za pomocg kabla USB dotgczonego do zestawu.

12. WEJSCIE ZASILANIA — Stuzy do podiaczenia skanera do standardowego zrédta
zasilania sieciowego za pomocg zasilacza wchodzacego w sktad zestawu.

13. KLAPA SKANERA — Pomaga utrzyma¢ skanowang kartke w miejscu a takze
chroni szybe skanera.

14. POKRYWA DOKUMENTU — Utrzymuje papier w miejscu i poprawia doktadnosc,
CO zapewnia wyzszg jakos¢ obrazu.

15. KRAWEDZ SKANOWANIA — Wyréwnaj kartke do tej krawedzi przy skanowaniu z
szyby.

16. SZYBA SKANERA — Miejsce, w ktorym ktadzie sie kartke przy skanowaniu z
szyby.



R0OzDzIAL |. INSTALACJA SKANERA

Przed rozpoczeciem instalacji skanera nalezy sprawdzi¢ kompletnos¢ zestawu.
Odpowiednia lista stanowi czes¢ rozdzialu ,Zawartos¢ pudetka” w niniejszym
podreczniku.

WYMAGANIA INSTALACYJNE OPROGRAMOWANIA

Skaner zostat wyposazony w oprogramowanie do rozpoznawania tekstu OCR
(ABBYY FineReader Sprint Plus), oprogramowanie do rozpoznawania wizytowek
(HotCard BizCard Finder), oprogramowanie do zarzadzania dokumentami (NewSoft
Presto! PageManager), sterownik skanera, DocAction oraz oprogramowanie do
przechwytywania obrazéw (Plustek DI Capture). Wszystkie powyzsze aplikacje po
instalacji na twardym dysku komputera zajmujg okoto 800 megabajtéw. Jednakze w
celu zapewnienia odpowiednio duzo miejsca na instalacje oraz na skanowanie i
zapisywanie obrazow nalezy zarezerwowaé 1 GB wolnego miejsca na dysku twardym.

Niniejszy skaner USB obstuguje jedynie systemy operacyjne Microsoft Windows
2000 Professional/ XP/ Vista/ 7.

WYMAGANIA SPRZETOWE

Skaner mozna podigczy¢ do komputera za posrednictwem uniwersalnej magistrali
szeregowej (USB), ktéra obstuguje technologie HOT PLUG AND PLAY. W celu
okreslenia, czy dany komputer zostat wyposazony w interfejs USB nalezy sprawdzié,
czy na jego tylnym panelu znajduje sie ztgcze USB przedstawione na rysunku ponizej.
W przypadku wystgpienia problemow z odnalezieniem portu USB na komputerze,
nalezy skonsultowac sie z podrecznikiem sprzetowym, ktory zostat dostarczony wraz z
komputerem.

Po blizszemu przyjrzeniu sie panelowi tylnemu mozna zazwyczaj znalez¢ dwa
prostokatne porty USB, ktére zazwyczaj wygladajg jak te przedstawione na rysunku
ponize;j.



\ED Ztgcza USB

Jesli komputer nie zostat wyposazony w porty USB, wtedy konieczne bedzie
zakupienie zatwierdzonej ptyty interfejsu USB, ktéra umozliwia dodanie opcji USB do
komputera.

INSTALACJA | KONFIGURACJA SKANERA

W celu instalacji skanera Plustek postepuj krok po kroku zgodnie z poleceniami

zawartymi w kolejnych punktach.

Najpierw wybierz wlasciwa lokalizacje!

® Przed rozpoczeciem konfiguracji skanera lub
przeprowadzaniem zadan  skanowania,
nalezy upewni¢ sie, ze skaner zostat
zainstalowany na réwnej, gtadkiej i
wytrzymatej powierzchni.

Qmmum:- Nieréwna powierzchnia lub powierzchnia z
ptytki moze spowodowac btedy pobierania
Uwaga papieru, uszkodzenie ciata lub skanera.

® Skanera nie powinno sie uzywaé w
miejscach zakurzonych. Drobinki kurzu oraz
niewielkie przedmioty moga dosta¢ sie do
jego wnetrza i spowodowaé uszkodzenie
urzadzenia.




Krok 1. Podtaczanie skanera do komputera

B2I( [ =

\i@
o

PC1 PC2 ﬁ
[}
= = if"-
() ((582)) N —
— e
- B@_/ I @‘e : -
L — f I'X::- “[—_.l" R

Il

(TN

l] LT TATEREATIR

Przed podtgczeniem lub odigczeniem zasilacza
Q‘"" Hen: sieciowego skanera nalezy upewni¢ sie, ze
skaner zostat wytaczony (OFF).

Uwaga

Podtacz zasilacz do gniazda w skanerze ©*©.

2. Podtacz drugi koniec zasilacza do standardowego gniazdka zasilajgcego.

3. Podtacz kwadratowg koncéwke dotgczonego kabla USB do PC1 portu USB e 2
tylu skanera.

4. Podiacz prostokatny koniec kabla USB do nieuzywanego portu USB w komputerze
1.

5. Podtacz kwadratowg kohcowke dotgczonego kabla USB do PC2 portu USB -z
tytu skanera.

6. Podtacz prostokatny koniec kabla USB do nieuzywanego portu USB w komputerze
2.

7. W celu podtaczenia skanera do koncentratora USB® upewnij sie, ze koncentrator
jest podtagczony do portu USB na komputerze. Nastepnie podtgcz skaner do

3 Koncentrator USB nie wchodzi w sktad zestawu.
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koncentratora USB.

Krok 2. Instalacja oprogramowania

1. Wiacz zasilanie skanera z tytu urzadzenia.

® Nacisnij przycisk PC1 na skanerze, aby
aktywowaé potagczenie skanera przed
rozpoczeciem instalacji oprogramowania na
Qﬂtmﬂm} komputerze 1.
® Nacisnij przycisk PC2 na skanerze, aby
aktywowaé potaczenie skanera przed
rozpoczeciem instalacji oprogramowania na
komputerze 2.

2. W przypadku gdy podtgczenia zostaty wykonane prawidtowo system wykryje nowe
urzadzenie uruchamiajac: “Kreator dodawania nowego sprzetu’ lub “Kreator
znajdowania nowego sprzetu’.

Jesli komputer jest wytgczony w momencie

P e podtgczania skanera, okno “Kreatora dodawania

0-' nowego sprzetu” nie zostanie wyswietlone, az do

Informacja  wigczenia komputera i uruchomienia systemu
Windows.

3. Dla Windows 2000:
a. Kiiknij przycisk Dalej w oknie “Kreatora dodawania nowego sprzetu”.

b. Wybierz ,Wyszukaj najlepszego sterownika dla tego urzadzenia
[Zalecane]” a nastepnie kliknij przycisk Dalej.

c. W kolejnym oknie musisz zaznaczy¢ gdzie majg by¢ wyszukiwane sterowniki.
Zaznacz naped CD-ROM i odznacz Stacja dyskéw (jesli opcja ta zostata
wybrana).

(

d. Wi6z do napedu CD w komputerze ptyte CD do instalacji urzadzenia /
oprogramowania, ktora zostata dotgczona do skanera i kliknij przycisk Dalej.

e. Kiiknij przycisk Dalej w nowym okienku.

f. Podczas instalacji moze zosta¢ wyswietlony komunikat o braku certyfikatu
sterownika. Zignoruj go i kliknij Tak, aby kontynuowac instalacje. Przejdz do
kroku 8.

4. Dla Windows XP:

a. Wi6z do napedu CD w komputerze ptyte CD do instalacji urzadzenia /
oprogramowania, ktora zostata dotgczona do skanera i kliknij przycisk Dalej.
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b.

C.

Wybierz Instaluj oprogramowanie automatycznie [Zalecane], a nastepnie
kliknij przycisk Dalej.

Kliknij przycisk Dalej w nowym okienku. Przejdz do kroku 7.

5. Dla Windows Vista:

a.

W oknie ,Znaleziono nowy sprzet” (Found New Hardware) wybierz “Odszukaj i
zainstaluj oprogramowanie sterownika [Zalecane]” (Locate and install driver
software (recommended)).

Gdy pojawi sie okno ,Kontrola konta uzytkownika” (User Account Control) kliknij
przycisk Kontynuuj (Continue).

Po pojawieniu sie komunikatu ,Wt6z dysk dostarczony z urzgdzeniem USB
Scanner” (Insert the disc that came with your USB Scanner), wt6z do napedu
CD w komputerze ptyte CD do instalacji urzadzenia / oprogramowania, ktora
zostata dotgczona do skanera i kliknij przycisk Dalej. Przejdz do kroku 8.

6. Dla Windows 7:
Gdy ptyta CD ze sterownikami i aplikaciami jest przeznaczona dla réznych modeli

skanera

a.

Wt6z ptyte CD, dotaczong do skanera do napedu CD w komputerze. Kliknij
Uruchom: install.exe w oknie Autoodtwarzanie, ktére zostanie wyswietlone.

Kliknij przycisk Tak, jesli wyswietli sie okno dialogowe Kontrola konta
uzytkownika. Wykonuj instrukcje w wyskakujagcym oknie z komunikatem o
instalacji.

W oknie Menedzer urzadzen, kliknij prawym klawiszem myszy ten skaner w
pozycji Inne urzadzenia i wybierz Aktualizuj oprogramowanie sterownika z
menu wyskakujgcego. Kliknij Przegladaj méj komputer w poszukiwaniu
oprogramowania sterownika w oknie, ktére zostanie wyswietlone, i kliknij
przycisk Przegladaj.

W oknie Przegladanie w poszukiwaniu folderu, wybierz folder lub naped CD-
ROM zawierajacy sterownik tego skanera i kliknij przycisk OK, aby powrdci¢ do
poprzedniego ekranu. Kliknij przycisk Dalej i kliknij Zainstaluj
oprogramowanie sterownika mimo to, jesli wysSwietli sie okno
Zabezpieczenia systemu Windows. Przejdz do kroku 9.

Gdy piyta CD ze sterownikami i aplikacjami jest przeznaczona dla jednego modelu

skanera

a.

Wt6z ptyte CD, dotgczong do skanera do napedu CD w komputerze. Kliknij
Uruchom: install.exe w oknie Autoodtwarzanie, ktére zostanie wyswietlone.

Kliknij przycisk Tak, jesli wyswietli sie okno dialogowe Kontrola konta
uzytkownika. Jesli wyswietli sie wyskakujagce okno kreatora, kliknij Dalej,
nastepnie Zainstaluj oprogramowanie sterownika mimo to w oknie
Zabezpieczenia systemu Windows. Kliknij Zakoncz w oknie kreatora. Przejdz
do kroku 9.
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7. Podczas instalacji moze zostanie wyswietlony komunikat “System Windows nie
moze zweryfikowaé wydawcy tego oprogramowania” (Windows can’t verify the
publisher of this driver software). Zignoruj go i kliknij Zainstaluj ten sterownik
oprogramowania mimo wszystko (Install this driver software anyway), aby
kontynuowac instalacje.

8. Po zakonczeniu instalacji kliknij przycisk Zakonicz.

9. Postepuj wedtug instrukcji na ekranie aby zainstalowaé oprogramowanie
wymagane do skanera.

10. Po zainstalowaniu oprogramowania zamknij wszystkie dziatajgce aplikacje i kliknij
przycisk Zakoncz, aby ponownie uruchomi¢ komputer.

11. Po ponownym uruchomieniu komputera zostaniesz poproszony o skalibrowanie
skanera.

12. Wiz specjalny arkusz kalibracyjny do podajnika ADF skanera.

13. Postepuj zgodnie z instrukcjami na ekranie aby przeprowadzi¢ proces kalibraciji.

Po zakonczeniu kalibracji kliknij OK, a nastepnie Zakoncz.

Jesli instalacja skanera nie uruchamia sie i nie

: wysSwietla sie automatycznie, kliknij Start, wybierz

0 opcje Uruchom i wprowadz D:\Install (gdzie D:

Informacja  oznacza odpowiednig litere przypisang do napedu
CD-ROM danego komputera.)

Krok 3. Testowanie skanera

Ponizsza procedura opisuje sposéb sprawdzania poprawnosci funkcjonowania
skanera przy uzyciu komputera oraz oprogramowania do skanowania poprzez
wykonanie pierwszego skanu za pomocg dotaczonego oprogramowania, tj. NewSoft
Presto! PageManager. Przed rozpoczeciem testowania skanera nalezy sprawdzi¢
poprawnos$¢ dokonanych podigczen.

Aby przeprowadzi¢ test skanowania z szyby:
1. Otworz klape skanera. Umies¢ dokument drukiem do dotu na szybie skanera i

wyréwnaj go do krawedzi skanowania
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2. Delikatnie zamknij klape skanera.

3. Kiliknij przycisk Start systemu Windows w celu uruchomienia oprogramowania
NewSoft Presto! PageManager.

4. (Jesli do komputera podtaczony jest tylko jeden skaner, przejdz od razu do
Kroku 5.)
Jesli posiadasz wiecej niz jeden skaner lub inne urzadzenie do przetwarzania
obrazéw zainstalowane na komputerze: Kliknij Select Source (Wybierz zrodto)
z menu File (Plik) aplikacji Presto! PageManager i wybierz ten skaner jako
domysine zrédto dla skanowania dokumentéw.

5. W aplikacji Presto! PageManager kliknij kolejno Tools > Scan Settings >
odznaczy¢ “Suppress TWAIN User Interface” > OK. Trzaskac¢ File > Acquire
Image Data.

6. Wybierz Szyba jako Typ skanowania w oknie TWAIN.
7. Kiliknij przycisk Skanuj.

8. Jesli na ekranie pojawit sie obraz skanowanego dokumentu skaner dziata
poprawnie.

Testowanie opcji skanowania z podajnika ADF:

1. Zataduj dokument nagtéwkiem do przodu i strong zadrukowang do dotu do
podajnika ADF. (Szczegotowe informacje na temat tadowania papieru do
podajnika ADF znajdujg sie w sekcji ,Ladowanie dokumentow”)
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2. Kiliknij przycisk Start systemu Windows w celu uruchomienia oprogramowania
NewSoft Presto! PageManager.

3. (Jesli do komputera podtaczony jest tylko jeden skaner, przejdz od razu do
Kroku 4.)
Jesli posiadasz wiecej niz jeden skaner lub inne urzgdzenie do przetwarzania
obrazéw zainstalowane na komputerze: Kliknij Select Source (Wybierz zrodto)
z menu File (Plik) aplikacji Presto! PageManager i wybierz ten skaner jako
domys$ine zrédto dla skanowania dokumentéw.

4. W aplikacji Presto! PageManager kliknij kolejno Tools > Scan Settings >
odznaczy¢ “Suppress TWAIN User Interface” > OK. Trzaska¢ File >
Acquire Image Data.

5. Woybierz ADF (awers) jako Typ skanowania w oknie TWAIN.
6. KIiknij przycisk Skanuj.

7. Dokument umieszczony w wejsciu podajnika ADF zostanie pobrany do
podajnika ADF i zeskanowany. Po zakonczeniu tego procesu na ekranie
powinien wyswietli¢ sie obraz tego dokumentu.

8. Kliknij Zamknij, aby zamknag¢ okno TWAIN.

INSTALACJA DODATKOWEGO OPROGRAMOWANIA

Zakupiony skaner obstuguje protokot TWAIN oraz dowolne oprogramowanie
pracujgce w tym standardzie. W przypadku zakupu oprogramowania do uzycia w
potaczeniu ze skanerem, zaleca sie sprawdzenie jego zgodnosci ze standardem
TWAIN standard.
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RozDzIAL Il. SKANOWANIE

Zakupiony skaner musi by¢é sterowany za posrednictwem oprogramowania
okreslonego rodzaju. Poniewaz wszystkie dokumenty i obrazy (zaréwno tekst, jak i
obrazy) pozyskane ze skanera sg traktowane przez komputer jako obrazy, wiekszos¢
operacji skanowania przeprowadza sie za posrednictwem aplikacji do edycji obrazéw,
ktéra umozliwia wyswietlenie, edycje, zapisanie i wydrukowanie zeskanowanych
obrazéw. Niniejszy skaner zostat wyposazony w taki program, ktéry znajduje sie na
ptycie CD-ROM do instalacji urzadzenia / oprogramowania. Taka aplikacja umozliwia
edycje i korekte skanowanych obrazéw za pomocg zestawu filtréw, narzedzi i efektéw
wizualnych.

A co ze skanowaniem dokumentéw tekstowych i ich pdzniejszg edycjg w edytorze
tekstu? Do tego stuzy oprogramowanie do rozpoznawania tekstu (OCR). Aplikacja
OCR umozliwia konwersje obrazéw utworzonych poprzez zeskanowanie dokumentéw
tekstowych do plikéw tekstowych, ktéore moga byé wyswietlane, edytowane i
zapisywane za pomocg edytoréw tekstu. Na ptycie CD-ROM do instalacji urzadzenia /
oprogramowania znajduje sie réwniez takie witasnie oprogramowanie do
rozpoznawania tekstu (OCR), tak wiec jedli chcesz wykorzystywaé skaner w ten
sposo6b, zalecamy zainstalowanie oprogramowania dostarczonego w zestawie.

Aplikacja DI Capture to, zgodnie ze swojgq angielskg nazwg, oprogramowanie do
przechwytywania obrazéw, ktére umozliwia fatwg konwersje dokumentéw papierowych
na elektroniczne, a nastepnie zapisanie ich do okreslonego folderu. Poza tym,
oprogramowanie to zostato wyposazone w funkcje kreatora skanowania (Scan Wizard),
ktéry poprowadzi nawet poczatkujacych uzytkownikow skanera po czynnosciach
wymaganych do pomysinego zeskanowania dokumentu.

Program DocAction zapewnia bezkonfliktowg integracje pracy skanera z
komputerem i innymi urzgdzeniami peryferyjnymi, a takze stanowi szybki i tatwy
sposob na korzystanie z wielu réznych funkcji skanowania. Aplikacja DocAction nie
wymaga wprowadzania ustawien skanowania dla kazdego uzycia urzadzenia;
wystarczy nacisniecie przycisku na przednim panelu skanera lub klikniecie dowolne;j
pozycji menu ekranowego DocAction, a skaner rozpoczyna skanowanie dokumentow
papierowych, a nastepnie przesyla je do okreslonego odbiorcy (czyli drukarki,
programu pocztowego, plikéw na twardych dyskach komputera czy do programu do
edycji obrazéw itp.)

W przypadku jakichkolwiek pytan lub watpliwosci zwigzanych z uzyciem
powyzszych programow do skanowania dokumentdéw zalecamy korzystanie z systemu
pomocy online.

Niniejszy rozdziat opisuje trzy kluczowe kroki sktadajace sie na kazda operacje
skanowania. Prosimy o doktadne zapoznanie sie i SciSle przestrzeganie ponizszych
instrukcji w celu zapewnienia poprawnosci uzycia oraz optymalnej wydajnosci skanera.

Krok 1. Aktywacja potaczenia ze skanerem
Krok 2. Przygotowywanie dokumentow
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Krok 3. Ladowanie dokumentéw, Ladowanie wizytowek
Krok 4. Skanowanie dokumentéw

AKTYWACJA POLACZENIA ZE SKANEREM

Skaner mozna potaczy¢ z dwoma komputerami za pomocg kabli USB. Zwieksza
to elastycznos¢ jego obstugi. Gdy uzytkownik chce skanowaé, moze wybrac jeden z
komputeréw, aktywowac jego potgczenie ze skanerem i rozpocza¢ skanowanie. Na
skanerze znajdujg sie przyciski PC1 i PC2, dzieki ktorym mozna przetaczac potaczenie
skanera z komputerem 1 na komputer 2 i na odwrot. Potgczenie ze skanerem i
komputerami aktywuje sie, naciskajac odpowiednio przyciski PC1 lub PC2 na skanerze.

Aby obstugiwac skaner z komputera 1, nalezy nacisng¢ przycisk PC1 na skanerze.
W obszarze powiadomien systemu Windows komputera 1 pojawia sie ikona '@i

zapala sie kontrolka przycisku PC1. Potaczenie skanera z komputerem 1 jest teraz
aktywne i mozna rozpocza¢ skanowanie.

Aby obstugiwac skaner z komputera 2, nalezy nacisng¢ przycisk PC2 na skanerze.
W obszarze powiadomieh systemu Windows komputera 2 pojawia sie ikona @i

zapala sie kontrolka przycisku PC2. Potaczenie skanera z komputerem 2 jest teraz
aktywne i mozna rozpoczg¢ skanowanie.

® Przed rozpoczeciem skanowania nalezy
upewni¢ sie, ze pofgczenie skanera z
komputerem jest aktywne.

® NIE PRZELACZAC potaczenia skanera za
pomocg przyciskbw PC1 lub PC2, gdy
skaner przetwarza zadania skanowania.

Q&mwm’- ® Domyslnie, gdy oba komputery — 1 i 2 — sg

potaczone ze skanerem i wtgczone, aktywne
jest tylko potaczenie skanera z komputerem
1 i Swieci sie kontrolka przycisku PC1. Gdy
potagczenie skanera z komputerem 1
zostanie zakonczone, kontrolka przycisku
PC1 zgasnie. Woéwczas automatycznie
zostanie aktywowane potgczenie skanera z
komputerem 2 i zapali sie kontrolka
przycisku PC2.

PRZYGOTOWYWANIE DOKUMENTOW

Prawidtowe przygotowanie dokumentéw przed rozpoczeciem skanowania
pozwala na unikniecie btedéw pobierania papieru oraz uszkodzen skanera.
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Sprawdzanie stanu dokumentow
Poluzowanie dokumentéw

Sprawdzanie stanu dokumentéw

Przed skanowaniem nalezy upewni¢ sie, ze format i gramatura stosu arkuszy jest
obstugiwana przez skaner. Dodatkowe informacje na ten temat znajdujg sie w sekgciji

“Zatgcznik A: Specyfikacje” niniejszego podrecznika.

Jednoczesne skanowanie wielu dokumentéw za pomoca podajnika ADF
umozliwia zwiekszenie wydajnosci pracy uzytkownika oraz znaczne uproszenie
wiekszych zadan skanowania. Podajnik ADF niniejszego skanera obstuguje rézne
rodzaje papieru oraz materiatow pismiennych, ktére moga znajdowaé zastosowanie w

codziennym zyciu lub pracy uzytkownika, takich jak as:

Standardowy papier o formacie i gramaturze spetniajacych wymagania

okreslone w sekcji “Zatgcznik A: Specyfikacje” niniejszego podrecznika.

Papier karbowany

Papier lakierowany (np. broszury)

W celu unikniecia btedéw w podawaniu papieru
oraz uszkodzenia podajnika ADF nalezy Scisle
przestrzegac ponizszych instrukciji:

® Przed zatadowaniem papieru do podajnika

ADF nalezy usung¢ z niego wszelkie mate
przedmioty takie jak spinacze, spinki,
zszywKi czy inne zapiecia.

Upewnic¢ sie, ze papier jest catkowicie ptaski i
nie posiada zagietych lub pogniecionych
rogoéw.

Unika¢ skanowania dokumentéw pisanych
otbwkiem oraz wycinkéw z gazet, gdyz
powodujg one zabrudzenie szyby oraz
wnetrza  podajnika  ADF. Jesli  takie
skanowanie jest konieczne, zaleca sie
znaczne zwiekszenie czestotliwosci
czyszczenia skanera (dodatkowe informacije
na ten temat znajdujg sie w sekcji “Rozdziat
Ill. Serwis i konserwacja” niniejszego
podrecznika).

Papier z jednego wktadu skanowanego przez
podajnik ADF moze charakteryzowaé sie
takg sama lub r6zng gramaturg, przy czym
wszystkie jednoczesnie skanowane
dokumenty muszg mie¢ tg samag dtugosé.
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Jedli skanowane dokumenty spetniajg ktéry$ z ponizszych warunkéw nalezy
skanowac je z szyby skanera:

B Papier o gramaturze nizszej niz 50 g/m? (14 Ib.) lub ciezszej niz 120 g/m? (32
Ib.)
Papier ze spinaczami lub zszywkami
Papier o zmiennej grubosci, np. koperty
Papier pognieciony, pozwijany, zgiety lub przedarty
Papier o niestandardowym (tj. innym od prostokatnego) ksztatcie
Kalka kreslarska
Kalka kopiujgca, papier wrazliwy na nacisk, papier samokopiujacy
Przedmioty inne niz papier, np. ptétno lub folia metalowa.

® NIE uzywac¢ podajnika ADF do skanowania
klisz fotograficznych lub oryginatow o
szczegoblnej wartosci; bitgd podawania
papieru moze spowodowac rozdarcie Iub

Qﬂmwm:- inne uszkodzenie takiego oryginatu.
® NIE fadowa¢ do podajnika ADF papieru z
Uwaga niewyschnietym atramentem lub

korektorem. W takim przypadku nalezy
odczeka¢ kilka minut do wyschniecia
atramentu lub korektora.

Poluzowanie dokumentéw (podajnik ADF)

Przed zatadowaniem dokumentow do podajnika ADF nalezy je poluzowaé¢ w
nastepujacy sposob:
1. Przewietrzy¢ dokumenty, co zapobiega sklejaniu sie arkuszy.

2. Trzymajgc dokumenty nagtéwkiem do dotu w obu dtoniach, delikatnie docisnij
je do ptaskiej powierzchni w celu wyréwnania krawedzi catego stosu.

Dzieki tym zabiegom dokumenty bedg podawane po jednym do podajnika ADF,
co umozliwi unikniecie btedéw podawania papieru.

L ADOWANIE DOKUMENTOW
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Szyba skanera
1. Otworz klape skanera.
2. Umies¢ dokument drukiem do dotu na szybie skanera i wyréwnaj go do

krawedzi skanowania

3. Powoli i delikatnie zamknij klape skanera.

Podajnik ADF

1. Zataduj dokument nagtowkiem do przodu i strong zadrukowang do dotu w
kierunku Srodkowej czesci wejscia podajnika ADF, az on dotknie dolnej
krawedzi podajnika.

Przy skanowaniu jednostronnym zataduj dokumenty tak, aby skanowany
papier byt skierowany skanowang strong w strone skanera.

Przy skanowaniu obustronnym zataduj dokumenty tak, aby skanowany papier
byt skierowany pierwszg strong kartki w strone skanera.

2. Dostosuj ustawienie prowadnicy szerokosci papieru do wielkosci uzywanego
papieru. Prowadnica powinna dotyka¢ lekko obu krawedzi bocznych
dokumentéw.
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® NIE tadowac wiecej niz 50 arkuszy papieru (70
g/m?, 18 Ib.) do podajnika ADF.

® Papier skanowany za  posrednictwem
podajnika ADF nie moze by¢ mniejszy niz 9 x
5,08 cm (3,55” x 27, szer. x dt.).

® Upewnij sie, ze prowadnica szerokosci
papieru dostata doci$nieta do stosu arkuszy; w
przeciwnym razie skanowane obrazy moga

Qﬂtﬂnﬂm- , .

zostac¢ skrzywione.

Uwaga ® Dokumenty powinny zosta¢  dokfadnie
zatadowane w celu zapewnienia maksymainej
doktadnoséci skanowania, ale nie powinny byé¢
one az tak mocno wcisniete, zeby proces ich
podawania do skanera zostat utrudniony.

® Nie fadowa¢ dodatkowych arkuszy, gdy
podajnik ADF wykonuje operacje podawania i
skanowania dokumentéw.

L ADOWANIE WIZYTOWEK

1.

Pionowo zataduj wizytéwki nagtdwkiem do przodu i strong zadrukowang do
dotu w kierunku srodkowej czesci wejscia podajnika ADF, az dotknie ona
dolnej krawedzi podajnika.

W przypadku skanowania jednostronnego wizytéwki nalezy wktadac¢ strong
zadrukowang do dotu.

W przypadku skanowania dwustronnego wizytowki mozna wktada¢ w dowolny
sposob.
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2. Dostosuj ustawienie prowadnicy szerokosci papieru do szerokosci wizytéwek.

Prowadnica powinna dotyka¢ lekko obu krawedzi bocznych wizytowek.

Jednorazowo nie nalezy tadowac¢ wiecej niz 10
wizytowek.

SKANOWANIE DOKUMENTOW

Dostepne sg cztery metody obstugi skanera:

1.

2.
3.
4.

Interfejs TWAIN oraz aplikacje DI Capture i DocAction sg automatycznie

Pozyskiwanie obrazéw za posrednictwem interfejsu TWAIN w ramach

dowolnego programu obstugujgcego ten standard tgcznosci.

Skanowanie obrazéw za pomocg oprogramowania DI Capture.

Skanowanie za pomocg przyciskéw na panelu przednim skanera.

Skanowanie za pomocg menu ekranowego Execute programu DocAction.

instalowane na danym komputerze w trakcie instalacji sterownika drukarki.

Przed rozpoczeciem skanowania nalezy
sprawdzi¢ nastepujace elementy:

Zasilanie zarbwno komputera, jak i skanera
jest wigczone.
W zasobniku sistemu Windows wyswietlana

jest ta ikona :

Papier zostat poprawnie zatadowany do
podajnika ADF.

Zamknij pokrywe podajnika ADF poprzez
wcisniecie jej z powrotem, az do jej
zablokowania. Otwarta pokrywa ADF
uniemozliwia prawidtowe skanowanie.
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Skanowanie za posrednictwem interfejsu TWAIN

TWAIN to bodaj najwazniejszy program stanowigcy wyposazenie niniejszego
skanera, gdyz stuzy on jako interfejs pomiedzy sprzetem skanera a oprogramowaniem
do edycji obrazéw, ktore stuzy uzytkownikowi do wyswietlania i edycji zeskanowanych
obrazéw. Program TWAIN umozliwia dostosowanie réznych ustawien, ktore okreslajg
jakos¢ skanowanego obrazu.

Ponizsza sekcja opisuje sposob wykorzystania dotgczonych aplikacji (NewSoft
Presto! PageManager), programu do rozpoznawania tekstu [OCR] (ABBYY
FineReader Sprint Plus) oraz oprogramowania do rozpoznawania wizytéwek (HotCard
BizCard Finder) w celu skanowania za posrednictwem interfejsu TWAIN. Gdy
uzytkownik wykazuje biegto$¢ w zakresie funkcji skanowania, wtedy moze on postuzy¢
sie innym oprogramowaniem do skanowania lub edycji obrazéw do wykonywania
zadan skanowania, o ile takie oprogramowanie jest kompatybilne z interfejsem TWAIN.

Wybér zrédta skanowania:

Jedli posiadasz wiecej niz jeden skaner lub inne urzadzenie do przetwarzania
obrazéw zainstalowane na komputerze, wtedy musisz wybraé niniejszy skaner jako
domysine zrédto dla skanowania dokumentéw przed pozyskaniem programu TWAIN.

1. Dla aplikacji NewSoft Presto! PageManager: W menu File (Plik) kliknij Select
Source (Wybierz zrédto). W wyskakujgcym oknie wybierz niniejszy skaner, a
nastepnie kliknij przycisk OK w celu ustawienia tego skanera jako domys$inego
zrédta skanowania.

2. Dla aplikacji ABBYY FineReader Sprint Plus: W menu Plik kliknij Wybierz
Skaner. W wyskakujgcym oknie wybierz niniejszy skaner, a nastepnie kliknij
przycisk OK w celu ustawienia tego skanera jako domysinego zrédta
skanowania.

3. Dla aplikacji HotCard BizCard Finder: Na gtéwnym pasku narzedzi kliknij
kolejno Settings > Acquire Options > Flatbed/TWAIN Scan, a nastepnie
Settings > Acquire Options > Select Flatbed/TWAIN Scanner. W
wyskakujgcym oknie wybierz niniejszy skaner, a nastepnie kliknij przycisk OK
w celu ustawienia tego skanera jako domysinego zrédta skanowania.

Skanowanie w programie NewSoft Presto! PageManager:

1. Kliknij przycisk Start systemu Windows, aby uruchomi¢ program Presto!
PageManager.

2. W aplikacji Presto! PageManager kliknij kolejno Tools > Scan Settings >
odznaczy¢ “Suppress TWAIN User Interface” > OK. Trzaska¢ File > Acquire
Image Data.

3. W otwartym oknie TWAIN z listy Typ skanowania: wybierz Szyba lub ADF
(awers) jesli chcesz skanowaé jednostronnie lub ADF (obustronnie) jesli
chcesz skanowac obustronnie.
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Profil; I j Zapizz Zarzgdzaj..

Ghavine IZaawansowaneI Preferencie | Informacie | | ()

Twp skanowania: I.-’-\DF [obustrannie] j
[ Ustawienia indywiduglne
¥ Potacz strany
" Poziome % Piorows

[ Feczna regulacia scalania

Rozrmiar strany: I.&utomatyczne razrmiar j
Trvb skanowania: |24-bit k.alar j
Rozdzielczode: |2DEI j I2EIIJ

Jasnoic: ﬂ J ﬂ ID—
K.ontrast: j J ﬂ ID—

— Ustawienia strarny:

¥ tutokadrowanie [T Automatyczne ohracanis
¥ futoprostowanie [ Autogestosc
Obrac: Brak, Odwrdd: Wik,

Przerzuc w poziomie: Wit., Przerzuc w piohie:

F.onfigur.. |

| [11.07 ME [ Auvers Rewers

Skanuj I Padglad I Zank.nij | Pomaoc | I-% a

4. Dostosuj ustawienia skanowania. W trybie ADF (obustronnie) mozna
wykadrowac¢ osobno awers jak i rewers. Do wyboru stuzg przyciski Awers i
Rewers pod oknem podgladu.

Aby wigczy¢ funkcje Potacz strony, nalezy wybra¢ w polu Typ skanowania
opcje ADF (obustronnie), a w polu Rozmiar strony — opcje Automatyczne
rozmiar. Funkcja ta pozwala umieszczac¢ awers i rewers przedmiotu w jednym
obrazie. Po wtgczeniu funkcji scalania stron mozna wybra¢ opcje Poziome, aby
taczy¢ awers i rewers poziomo w scalonym obrazie (rewers jest umieszczany
po prawej stronie awersu) lub opcje Pionowe, ktéra pozwala taczyé awers i
rewers pionowo w scalonym obrazie (rewers jest umieszczany ponizej awersu).

5. Zaladuj jedng strone dokumentu i kliknij przycisk Podglad. W oknie podgladu
wyswietlony zostanie zeskanowany obraz. Aby okresli¢ marginesy lub okresli¢
sekcje do ignorowania podczas skanowania, uzyj myszki w celu klikniecia i
przeciggniecia rogéw lub bokow granicy obszaru skanowania. Ponownie
dostosuj ustawienia skanowania, jesli obraz podgladu nie spetnia Twoich

wymagan.

6. Zataduj pozostate strony dokumentu i kliknij przycisk Skanuj.

7. Po zakonczeniu skanowania kliknij przycisk Zamknij w celu zamkniecia okna
TWAIN. Zeskanowane obrazy zostang wyswietlone za pomocg aplikacji Presto!
PageManager, umozliwiajg edycje obrazu.

Nacisniecie przycisku Pomoc w oknie TWAIN spowoduje wyswietlenie wiekszej

ilosci informacji dotyczacych konfiguracji przyciskéw.
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Skanowanie w programie ABBYY FineReader Sprint Plus: FINEREADER

1.

Kliknij przycisk Start systemu Windows i wybierz kolejno Wszystkie Programy
> ABBYY FineReader Sprint Plus, a nastepnie kliknij ABBYY FineReader
Sprint Plus, aby uruchomi¢ aplikacje FineReader.

Skanowanie jednej strony za pomocg szybie skanera:

-

Kliknij Samg i nastepnie wybierz opcje Skanuj obraz z menu
rozwijanego.
Skanowanie wielu stron za pomocg podajnika ADF:

-

Kliknij Ry i nastepnie wybierz opcje Skanuj wiele obrazéw z menu
rozwijanego.

W otwartym oknie TWAIN z listy Typ skanowania: wybierz Szyba lub ADF
(awers) jesli chcesz skanowaé jednostronnie lub ADF (obustronnie) jesli
chcesz skanowac obustronnie.

Dostosuj ustawienia skanowania. W trybie ADF (obustronnie) mozna
wykadrowa¢ osobno awers jak i rewers. Do wyboru stuzg przyciski Awers i
Rewers pod oknem podgladu.

Aby wigczy¢ funkcje Potacz strony, nalezy wybra¢ w polu Typ skanowania
opcje ADF (obustronnie), a w polu Rozmiar strony — opcje Automatyczne
rozmiar. Funkcja ta pozwala umieszcza¢ awers i rewers przedmiotu w jednym
obrazie. Po wtgczeniu funkcji scalania stron mozna wybraé opcje Poziome, aby
taczy¢ awers i rewers poziomo w scalonym obrazie (rewers jest umieszczany
po prawej stronie awersu) lub opcje Pionowe, kiéra pozwala tgczy¢ awers i
rewers pionowo w scalonym obrazie (rewers jest umieszczany ponizej awersu).
Zataduj jedng strone dokumentu i kliknij przycisk Podglad. W oknie podgladu
wysSwietlony zostanie zeskanowany obraz. Aby okresli¢ marginesy lub okresli¢
sekcje do ignorowania podczas skanowania, uzyj myszki w celu klikniecia i
przeciggniecia rogéw lub bokdéw granicy obszaru skanowania. Ponownie
dostosuj ustawienia skanowania, jesli obraz podgladu nie spetnia Twoich
wymagan.

Zataduj pozostate strony dokumentu i kliknij przycisk Skanuj.

Zeskanowane obrazy zostang wyswietlone w oknie gtdwnym FineReader, skad
mozna wiagczy¢ opcje rozpoznawania tekstu, ktére umozliwiajg konwersje
obrazéw do dokumentow pdf lub innych edytowalnych formatéw tekstowych.

® W przypadku czestego skanowania
obrazéw przy tych samych ustawieniach,
aplikacja ta umozliwia okreslenie profilu

: skanowania i zapisania skonfigurowanych
0 ustawien poprzez wprowadzenie nowej
Informacja nazwy lub opisu dla tego nowego profilu w

biatym obszarze obok stowa Profil, a
nastepnie klikniecie przycisku Zapisz.
® Przy nastepnym skanowaniu podobnych
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dokumentdéw, wystarczy wybrac ten profil z
listy rozwijanej i klikng¢ przycisk Skanuj w
celu zastosowania tych samych ustawien.

Nacisniecie przycisku Pomoc w oknie TWAIN spowoduje wyswietlenie wiekszej
ilosci informacji dotyczacych konfiguracji przyciskéw.

Skanowanie w programie HotCard BizCard Finder:
1. Kliknij przycisk Start systemu Windows, a nastepnie wybierz kolejno Wszystkie

. W tym oprogramowaniu kliknij ikone
. W otwartym oknie TWAIN z listy Typ skanowania: wybierz Szyba lub ADF

Programy > Program do rozpoznawania wizytowek, a nastepnie kliknij
Program do rozpoznawania wizytéwek w celu uruchomienia programu do
rozpoznawania wizytéwek.

e na giéwnym pasku zadan.

(awers) jesli chcesz skanowaé jednostronnie lub ADF (obustronnie) jesli
chcesz skanowac obustronnie.

Dostosuj ustawienia skanowania (Rozmiar papieru: Automatyczny;
Rozdzielczoé¢: 300 — czyli odpowiednio Paper Size: Automatic Size, Resolution:
300). W trybie ADF (obustronnie) mozna wykadrowac¢ osobno awers jak i
rewers. Do wyboru stuzg przyciski Awers i Rewers pod oknem podgladu.

Aby wigczy¢ funkcje Polacz strony, nalezy wybra¢ w polu Typ skanowania
opcje ADF (obustronnie), a w polu Rozmiar strony — opcje Automatyczne
rozmiar. Funkcja ta pozwala umieszczac¢ awers i rewers przedmiotu w jednym
obrazie. Po wigczeniu funkcji scalania stron mozna wybrac¢ opcje Poziome, aby
taczy¢ awers i rewers poziomo w scalonym obrazie (rewers jest umieszczany
po prawej stronie awersu) lub opcje Pionowe, ktdéra pozwala tgczyé awers i
rewers pionowo w scalonym obrazie (rewers jest umieszczany ponizej awersu).

Zataduj jedng wizytéwke i kliknij przycisk Podglad. W oknie podgladu zostanie
wyswietlony zeskanowany obraz.

. Zataduj wszystkie wizytowki i kliknij przycisk Skanuj.

Zeskanowane obrazy zostang wyswietlone w gtéwnym oknie BizCard Finder,
skad mozna wiaczy¢ opcje rozpoznawania tekstu, ktére umozliwiajg konwersje
obrazoéw do edytowalnych formatow tekstowych.

Nacisniecie przycisku Pomoc w oknie TWAIN spowoduje wyswietlenie wiekszej
ilosci informaciji dotyczacych konfiguracii przyciskow.

Skanowanie za pomoca aplikacji Plustek DI Capture

1.

Kliknij przycisk Start systemu Windows, aby uruchomi¢ aplikacje DI Capture.
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Profil skanowania

& 0l Capture

M Edvcia Widoh Shanu Obrar Fomoc

Wybor E::W a":‘“:’:& 'E" = —= = . =] Zwmiui _.'!wg_Pasek
skanera = ——m Q a 1 oot | B g . narzedzi
Okno
Okpo ¢ podgladu
folderow

Okno

< przegladarki

Pz obeaz w kel podglady. Dk 577 Gl wolheo mieisca

Okno ustawien skanowania

2. W programie DI Capture wybierz niniejszy skaner z listy rozwijanej
E |ScannerMDdel MName ﬂ

3. W Oknie folderéw wybierz folder docelowy do zapisywania zeskanowanych
obrazow.

(W celu utworzenia nowego folderu i / lub nowego dokumentu, kliknij przycisk
Nowy folder oraz / lub Nowy dokument na pasku narzedzi.)

4. Wybierz wiasciwy profil skanowania. (Mozesz klikng¢ zaktadke Ustawienia
skanowania w celu sprawdzenia, czy biezace ustawienia wybranego profilu
skanowania spetniajg Twoje wymagania. Jesli nie, kliknij przycisk Utwoérz lub
Zarzadzaj, ktory znajduje sie obok Scan Profile (Profilu skanowania) w celu
utworzenia nowego profilu lub wprowadzenia zmian do istniejgcego.)

5. Z paska narzedzi kliknij przycisk Skanuj — dotacz.

6. Po zakonhczeniu skanowania wszystkie zeskanowane obrazy bedg wyswietlane
w Oknie przegladarki. Ostatnio zeskanowany obraz wyswietlany bedzie w
Oknie podgladu.

Z paska narzedzi mozna réwniez wybra¢ opcje Kreator skanowania, ktéra
poprowadzi uzytkownika po czynnosciach wymaganych do pomysinego zeskanowania
dokumentu.

Interfejs aplikacji DI Capture mozna dostosowa¢ do wymagah danego
uzytkownika, zmieniajgc przyciski na pasku narzedzi, panel podgladu, panel
przegladarki itp.

Dodatkowe informacje na temat aplikacji DI Capture znajdujg sie w systemie
pomocy online DI Capture!

Skanowanie za pomoca przyciskéw na przednim panelu lub
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programu DocAction

Wszystkie przyciski szybkiego dostepu skanera mogq zosta¢ skonfigurowane w
aplikacji DocAction. DocAction zapewnia dostep do najczesciej uzywanych funkciji
skanera. Jest to najbardziej przydatne, gdy czesto skanujesz dokumenty z takimi
samymi ustawieniami i wysytasz obrazy w te same miejsca.

Przyciski skanera zostang opisane na przyktadzie przyciskow znajdujacych sie na
przednim panelu skanera. Mozesz osiggng¢ takie same rezultaty korzystajac z menu
~Wykonaj” aplikacji DocAction.

Konfiguracja przyciskéw

Przed pierwszym skanowaniem za pomocg przyciskow zaleca sie ich
wczesniejszg konfiguracje i dopasowanie do twoich wymagan. Konfiguracje przyciskow
DocAction mozna wyswietli¢ i zmieni¢ na dwa sposoby:

® \Wykona¢ dwuklik na ikonie '@ w zasobniku systemu Windows.

® Klikng¢ prawym przyciskiem myszy na ikonie '@ w zasobniku systemu
Windows i wybra¢ z menu Konfiguracja przyciskéw.

Z lewej strony okna ,Konfiguracja przyciskow” widoczne sg ikony odpowiadajgce
przyciskom szybkiego dostepu (zaréwno tym z przedniego panelu skanera jak i tym z
menu ,Wykonaj” aplikacji DocAction). Klikniecie na dowolnej ikonie z lewego panelu
spowoduje wyswietlenie jego ustawien po prawej stronie okna. Mozesz zmienié
ustawienia w sposéb najbardziej odpowiadajgcy twoim potrzebom.

Nacisniecie przycisku Pomoc w oknie ,Konfiguracja przyciskow” spowoduje
wyswietlenie wiekszej ilosci informaciji dotyczgacych konfiguracji przyciskow.

Skanowanie za pomoca przyciskéw szybkiego dostepu

Skanowanie dokumentow i obrazéow tym skanerem jest bardzo proste i zostato
opisane w ponizszych dwoch krokach:

1. Umies¢ dokumenty lub obrazy w skanerze. (Wiecej na temat umieszczania
dokumentédw mozna znalez¢ w czesci “Rozdziat Il. Skanowanie” niniejszej
instrukciji.)

then““f_ Przy skanowania przy uzyciu przycisku OCR
N uzywaj wytgcznie dokumentow tekstowych. Nie
Uwaga skanuj obrazéw przyciskiem OCR.

2. Aby rozpocza¢ skanowanie wykonaj jedng z ponizszych czynnosci:
® Nacisnij przycisk na przednim panelu skanera.
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® Kliknij prawym przyciskiem myszy na ikonie '@ w zasobniku systemu
Windows, wybierz z menu opcje Wykonaj a nastepnie opcje
odpowiadajacq przyciskowi.
Skaner zaczyna wykonywac akcje zadang w oknie ,Konfiguracja przyciskow”.

W przypadku wigczenia skanowania za pomocag
przycisku rozpoznawania tekstu (OCR) programu
DocAction, za kazdym razem mozesz

QMWM:- zeskanowacé maksymalnie 50 arkuszy
zadrukowanego jednostronnie papieru;
Uwaga ograniczenie to wynika z limitu skanowanych

arkuszy programu ABBYY FineReader 6.0 Sprint
Plus.
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RozDzIAL lll. SERWIS | KONSERWACJA

Zakupiony skaner zostat zaprojektowany jako urzadzenie niewymagajace
konserwacji. Mimo tego, regularne wykonywany serwis i konserwacja urzadzenia
umozliwia zapewnienie bezproblemowej pracy skanera.

CZYSZCZENIE SKANERA

Pyt, kurz, tusz i toner ze skanowanego papieru moze powodowac zabrudzenie
szyby skanera, co prowadzi do pogorszenia jakosci skanowania a takze do zaciec
papieru w podajniku. Czestotliwosé czyszczenia zalezy od jakosci i ilosci skanowanego
papieru.

Zapoznaj sie z ponizszymi operacjami, aby wyczysci¢ obudowe, szybe i podajnik
ADF skanera. Delikatnie oczy$¢ kazde opisane tu miejsce.. Nie trzyj za mocno.

® Przed rozpoczeciem czyszczenia skanera

nalezy wylgczy¢ urzadzenie, a takze

odtaczy¢ kabel zasilajgcy oraz kabel USB

skanera, a nastepnie trzeba odczekac¢ kilka

minut na ostygniecie szyby oraz / Ilub

wewnetrznej czesci podajnika ADF do
temperatury otoczenia.

® Po zakonczeniu czyszczenia skanera nalezy
przemy¢ dtonie wodg z mydtem.

Ostrzezenie

Materialy do czyszczenia

Przygotuj nastepujace materiaty do czyszczenia skanera:

B miekka, sucha, niestrzepigca sie sciereczka (lub bawetniany patyczek
higieniczny)

B niezracy srodek do czyszczenia — Alkohol izopropylowy (95%). NIE
uzywac wody.

® Do czyszczenia szyby skanera mozna réwniez uzy¢
srodka do mycia szyb Ilub neutralnego s$rodka
thum czyszczacego stuzacego do mycia okien.
® NIE uzywac tych Srodkéw do czyszczenia rolki
podajnika ADF lub modutu ochronnego.

Uwaga

Uzycie innych materiatdbw do czyszczenia moze doprowadzi¢ do uszkodzenia
skanera.
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Czyszczenie szyby skanera

1. Otwoérz klape skanera.
2. Delikatnie przetrzyj ponizsze miejsca $ciereczkg nasgczong Srodkiem
czyszczacym. Badz ostrozny, zeby NIE zarysowac ich powierzchni.

Czyszczenie pokrywy dokumentu i szyby skanera:

pokrywa
dokumentu

szyba
skanera

Qﬁtmﬁ o  Nie rozpylaj srodka czyszczacego bezposrednio
. na szybe skanera. Nadmiar ptynu moze
spowodowa¢ zamglenie lub uszkodzenie skanera.

Uwaga

3. Poczekaj do catkowitego wyschniecia czyszczonych miejsc.

4. Delikatnie zamknij klape skanera.

30



Czyszczenie podajnika ADF
1. Otworz pokrywe ADF.

pokrywe ADF

2. Delikatnie wytrze¢ nastepujgce obszary przy uzyciu Sciereczki zwilzonej
srodkiem czyszczacym. Uwazaj, aby NIE porysowac czyszczonych powierzchni.

Czyszczenie rolki podajnika:

Przetrzyj rolke podajnika od jednego boku do drugiego, a nastepnie obréé
czyszczony element. Powtarzaj czynnoS¢ az do wyczyszczenia catej
powierzchni rolki.

Czyszczenie modutu ochronnego:

Przetrzyj modut ochronny od géry do dotu (w kierunku wskazanym strzatkg na
ponizszym rysunku). Uwazaj, aby nie uszkodzi¢ sprezyn chwytajgcych na
module.
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Nie nalezy aplikowaC¢ s$rodka czyszczacego
bezposrednio na szybe skanera, gdyz
pozostatosci ptynu mogq spowodowac
zadymienie lub uszkodzenie skanera.

3. Odczekaj na catkowite wyschniecie wyczyszczonych obszaréw.

4. Zamknij pokrywe podajnika ADF poprzez wcisniecie jej z powrotem, az do jej

zablokowania.

WYMIANA MATERIALOW EKSPLOATACYJNYCH

Zaleca sie wymiane modutu pokrywy dokumentu co 25000 zeskanowanych stron.

Wymiana modutu pokrywy

1. Otwoérz pokrywe ADF.
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pokrywe ADF

3. Zainstaluj nowy modut podkfadki, wktadajgc wypustki modutu w odpowiednie
gniazda w skanerze.

4. Zamknij pokrywe podajnika ADF poprzez wcisniecie jej z powrotem, az do jej
zablokowania.
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KALIBRACJA SKANERA

W przypadku wystgpienia kolorow w biatych obszarach lub duzej roznicy miedzy
kolorami zeskanowanego pliku a kolorami oryginatu nalezy wykona¢ kalibracje skanera.
Taka operacja umozliwia dostosowanie i wyrdwnanie odstepstw, ktére w miare uptywu

czasu bedg wystepowac w elemencie optycznym z racji jego charakterystyki.

Ponizsza procedura okresla sposdb kalibracji skanera:

1. Arkusz kalibracyjny stuzy do kalibracji funkcji skanowania z automatycznym

podajnikiem dokumentow (ADF).

2. Wi6z specjalny arkusz kalibracyjny do podajnika ADF skanera.

Do kalibracji nalezy uzywaé specjalnego arkusza
kalibracyjnego dostarczonego ze skanerem.
Istnieje rowniez mozliwos¢ uzycia dowolnej i
pustej kartki biatego papieru w formacie A4 (216
na 297 mm), przy czym wyniki kalibracji
przeprowadzonej za pomocg takiego arkusza
mogq nie by¢ tak dobre, jak w przypadku uzycia
specjalnego arkusza kalibracyjnego.
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3. Kliknij Start > Wszystkie Programy > Nazwa modelu skanera > Kreator
kalibraciji.

4. Kiliknij Dalej w wyskakujacym oknie kreatora kalibracji, a nastepnie kliknij opcje
Skalibruj teraz.... Naciénij Start, aby rozpocza¢ proces kalibracji dla materiatow
skanowanych z szyby skanera. Po zakonczeniu procesu kliknij OK.

5. Kiiknij Skalibruj teraz.... Kliknij przycisk Start, aby rozpocza¢ proces kalibraciji
ADF.

6. Skaner pobierze arkusz kalibracyjny i przepusci go przez urzadzenie, w ten
sposob przeprowadzajgc kalibracje tego ostatniego. Po zakonczeniu procesu
kliknij OK, a nastepnie Anuluj.

OSZCZEDZANIE ENERGII

Aby zaoszczedzi¢ zuzycie energii, kiedy skonczy sie proces skanowania, lampa
skanera wylgcza sie i skaner automatycznie przechodzi w tryb niskiego poboru mocy.
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RozpziAL V.

WYKRYWANIE | USUWANIE AWARII

W przypadku wystgpienia probleméw ze skanerem zaleca sie ponowne
przejrzenie instrukcji instalacji i skanowania zawartych w niniejszym podreczniku.

Przed zgtoszeniem sprawy do obstugi klienta lub oddania urzadzenia do naprawy
nalezy zapoznac sie z informacjami zawartymi w niniejszym rozdziale oraz zapoznac¢
sie z naszymi odpowiedziami na Czesto zadawane pytania, kiére mogg zawierac
uzyteczne informacje na temat wykrywania i usuwania awarii. Z menu START systemu
Windows wybierz Wszystkie Programy > Nazwa modelu skanera, a nastepnie kliknij
FAQ (Czesto zadawane pytania).

PODLACZANIE SKANERA

Przy podejmowaniu préby usuwania probleméw z potgczeniem nalezy najpierw

sprawdzi¢ wszystkie potgczenia fizyczne. lkona @ ktéra znajduje sie w zasobniku
systemu Windows, wskazuje, czy oprogramowanie skanera zostato prawidtowo
uruchomione, a komputer pomysinie nawigzat fgcznos¢ ze skanerem.

lkona Stan

@ Program zostat uruchomiony, skaner jest pofgczony z
komputerem, potaczenie jest aktywne i mozna rozpoczaé
skanowanie.

@ Skaner nie jest potaczony z komputerem, potaczenie nie jest
aktywne lub skaner nie jest wtgczony.

Brak Wytaczono program; stan potaczenia miedzy komputerem a
skanerem jest bez znaczenia.

USUWANIE ZACIEC PAPIERU

W przypadku wystapienia zaciecia papieru w podajniku ADF nalezy podjaé
nastepujace kroki naprawcze:

1. Usuh wszystkie niezakleszczone dokumenty, ktére zostaly zatadowane do
podajnika ADF.

2. Otwoérz pokrywe ADF.
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pokrywe ADF

3. Delikatnie, ale stanowczo wyciagnij zaciety papier z podajnika ADF. Uwazaj,
aby nie zgniesc¢ lub nie pognie$¢ dokumentu.

Nie nalezy z podajnika ADF wyjmowac papierow,

§ ktore ulegty zacieciu lub ktorych skanowanie nie
o zostato ukonczone bez wczes$niejszego otwarcia
pokrywy ADF. W przeciwnym razie moze dojs¢ do

Uwaga
trwatego uszkodzenia podajnika ADF.

4. Zamknij pokrywe podajnika ADF poprzez wcisniecie jej do dotu, az do
zablokowania.
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ZAYACZNIK A: SPECYFIKACJE"

Plustek PL1530

Rozdzielczo$¢ optyczna

600 dpi

Maks. rozdzielczos¢
interpolowana

Szyba: 600 x 1200 dpi
ADF: 600 x 600 dpi

Tryby skanowania

Kolor: 48 bitow wewn.; 24 bitéw zewn.
S: 16 bitéw wewn.; 8 bitdw zewn.
Czarno-biaty: 1 bit

Technologia

Kontaktowy przetwornik obrazu kolorowy (CIS)

Pojemnos¢ podajnika
ADF

50 arkuszy (Ad/Letter, 70 g/m2 lub 18 funtow)
Uwaga: Maksymalna pojemno$¢ podajnika ADF zalezy
od gramatury papieru.

Szybkos¢ skanowania za
pomocg podajnika ADF

9 str. na min./10 cali na minute (200 dpi, kolor, A4
portret)

15 str. na min./30 cali na minute (200 dpi, skala
szarosci, A4 portret)

15 str. na min./30 cali na minute (200 dpi, czarno-biaty,
A4 portret)

Uwaga: Szybkosc¢ zalezy od aplikacji uzytej do
skanowania, posiadanego procesora w komputerze oraz
ilosci pamieci w systemie.

Obszar skanowania
(szer. x dt.)

Szyba:
Maksimum 216 x 297 mm (lub 8.5” x 11.69”)
Minimum 12.7 x 12.7 mm (lub 0.5” x 0.5”)
ADF:
Maksimum 220 x 356 mm (lub 8.66” x 14”)
Minimum 12.7 x 12.7 mm (lub 0.5” x 0.5”)

Dopuszczalne rozmiary
papieru (W x L)

Szyba:
Up to A4d/Letter size (lub 8.5” x 11.69”)
ADF:
Maksimum 220 x 356 mm (lub 8.66” x 14”)
Minimum 90 x 50.8 mm (lub 3.55” x 27)

Dopuszczalna gramatura
papieru dla podajnika
ADF

50 do 120 g/m? (lub 14 do 32 funtéw)

Dzienna liczba skanowan
(arkuszy)

1000

Zasilacz sieciowy

DC 24 V (prad staty), 0,75 A

Interfejs

USB 2.0 High Speed

Temperatura robocza

5°C do 40°C (41°F do 104°F)

4 Specyfikacje sprzetu moga ulec zmianie bez powiadomienia.
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Wilgotnos¢ wzgledna

20% do 80% (bez kondensaciji)

Wymiary (szer. x gt. x
wys.)

418 x 326 x 101 mm (16.45” x 12.83" x 4”)

Waga 3.78 Kgs (10.1 funta)
Protokoty Zgodnos¢ z TWAIN
Zgodnoscé

elektromagnetyczna

Przepisy FCC, Klasa B, CE

Zgodnos¢ z dyrektywam

WEEE/ ROHS
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ZALACZNIK B:

OBSLUGA KLIENTA | GWARANCJA

Dalszg pomocg mozna uzyskac¢ poprzez odwiedzenie naszej witryny internetowej
lub skontaktowanie sie z centrum obstugi na numer telefoniczny podany na ostatniej
stronie niniejszego podrecznika. Przedstawiciele Plustek chetnie zaoferujg swojg
pomoc w dniach od poniedziatku do pigtku, w trakcie normalnych godzin pracy.

W celu zapewnienia szybkiej obstugi klienta, prosze przygotowac nastepujace
informacje jeszcze przed wybraniem numeru centrum:
B Nazwa i numer modelu skanera
Numer seryjny skanera (znajdujacy sie u dotu skanera)
Wersja CD skanera oraz numer czesci
Szczegotowy opis problemu
Producent i numer modelu komputera
Predkos$¢ procesora
Biezacy system operacyjny i wersja BIOS-u (opcjonalnie)
Nazwa pakietu(-6w) oprogramowania, numer wersji lub wydania, a takze
producent oprogramowania
Zainstalowanie innych urzadzen USB

INFORMACJE DOTYCZACE SERWISU | POMOCY
TECHNICZNEJ

Informacje dotyczace okresu dostepnosci czesci zamiennych i mozliwosci
modernizacji produktéw, o ile majg zastosowanie, Informacje na temat czesci
zamiennych i mozliwosci modernizacji produktéw mozna uzyskaé od lokalnych
dystrybutoréw i dostawcow.

Informacje wymagane przez wiasciwg organizacje ds. implementacji. Informacje
dotyczace raportu z testu przeprowadzonego przez organizacje ds. implementacji
mozna uzyskac¢ u lokalnych dystrybutoréw i dostawcéw.

Przed utylizacjq jakiegokolwiek produktu nalezy zasiegng¢é u lokalnych
dystrybutoréw i dostawcéw informaciji na temat ograniczania szkodliwego wptywu na
srodowisko naturalne poprzez stosowanie wtasciwych metod i procedur.

Aby utylizowaé produkt oraz/lub akcesoria, nalezy sie zwréci¢ do lokalnych
dystrybutoréw i dostawcow o informacje kontaktowe dotyczace najblizszego zaktadu
zajmujgcego sie utylizacja.

W razie pytah dotyczacych konserwacji nalezy sie zwrdci¢ do lokalnych
dystrybutoréw i dostawcéw o informacje kontaktowe dotyczace najblizszego centrum
serwisowego, aby przedtuzy¢ okres uzytkowania produktu.
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Aby serwisowac i utylizowac¢ produkt we wtasciwy sposob, nalezy sie zwrdci¢ do
lokalnych dystrybutoréw i dostawcow o informacje dotyczace najblizszego sklepu.

OSWIADCZENIE O OGRANICZONEJ GWARANCJI

Oswiadczenie o ograniczonej gwarancji dotyczy jedynie opcji, kidore zostaty
oryginalnie zakupione przez uzytkownika u autoryzowanego sprzedawcy do uzytku
wiasnego, a nie w celu odprzedazy.

Gwarancja producenta dotyczy wszystkich czesci i robocizny, przy czym nie jest
ona wazna bez dowodu oryginalnego zakupu. W celu uzyskania serwisu
gwarancyjnego nalezy skontaktowa¢ sie z autoryzowanym sprzedawcg lub
dystrybutorem, odwiedzi¢ naszg witryne internetowg, ktéra zawiera informacje o
serwisie lub tez wystac pocztg elektroniczng zadanie dalszej pomocy.

W przypadku przekazania tego produktu innemu uzytkownikowi, obstuga
serwisowa oferowana jest dla nowego uzytkownika przez pozostaty okres gwarancyjny.
Razem z urzgdzeniem nalezy przekaza¢ dowodd zakupu oraz niniejsze oswiadczenie.

Gwarantujemy prawidtowe funkcjonowanie urzadzenia oraz zachowanie jego
opisow funkcjonalnych zawartych w dotaczonej dokumentacji. Po przedstawieniu
dowodu zakupu, czesci zamienne uzyskajg ochrone gwarancyjng na pozostaty okres
gwarancyjny zastepowanych czesci.

Przed przekazaniem tego produktu do serwisu gwarancyjnego nalezy usung¢ z
niego wszelkie programy, dane oraz przenosne urzgdzenia pamieci masowej.
Urzadzenia odestane bez podrecznika uzytkownika oraz oprogramowania zostang
zwrocone bez tych elementow.

Niniejsza Ograniczona Gwarancja nie dotyczy wymiany urzgdzenia w przypadku
uszkodzenia spowodowanego przez wypadek, katastrofe, akty wandalizmu,
nieprawidtowe lub nadmierne korzystanie, niewtasciwe srodowisko pracy, modyfikacje
w programie, inne urzadzenie lub modyfikacje w produkcje wprowadzane przez osobe
inng niz sprzedawca.

Jesli ten produkt stanowi funkcje opcjonalng, wtedy niniejsza Ograniczona
Gwarancja stosuje sie jedynie w przypadku jej uzycia w potaczeniu z urzgdzeniem, dla
ktérego ona zostata zaprojektowana.

Wszelkie pytania i watpliwosci w zakresie Ograniczonej Gwarancji nalezy
kierowa¢ do autoryzowanego sprzedawcy, u ktérego zakupiony zostat niniejszy produkt.

NINIEJSZA OGRANICZONA GWARANCJA ZASTEPUJE WSZELKIE INNE
GWARANCJE, ZAROWNO WYRAZNE JAK | DOROZUMIANE, W TYM, BEZ
OGRANICZEN, WSZELKIE DOROZUMIANE GWARANCJE DOTYCZACE
PRZYDATNOSCI HANDLOWEJ LUB PRZYDATNOSCI DO OKRESLONEGO CELU.
JESLI PRZEPISY PRAWNE NIE DOPUSZCZAJA WYLACZENIA GWARANCJI
DOROZUMIANYCH, WTEDY WSZELKIE GWARANCJE, ZAROWNO WYRAZNE JAK
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| DOROZUMIANE, BEDA OBOWIAZYWAC JEDYNIE W OKRESIE GWARANCYJNYM.
PO JEGO UPLYWIE ZADNE INNE GWARANCJE NIE BEDA MIALY
ZASTOSOWANIA.

W niektorych jurysdykcjach niemozliwe jest ograniczenie okresu obowigzywania
gwarancji dorozumianej; w takich przypadkach powyzsze ograniczenie sie nie stosuje.

Producent w Zzadnym wypadku nie ponosi odpowiedzialnosci za nastepujgce
straty:

1. Roszczenia stron trzecich wobec uzytkownika z tytutu poniesionych strat.
2. Utrata lub uszkodzenie akt lub danych, lub

3. Finansowe straty wtérne (w tym utrata zysku lub oszczednosci) lub uboczne,
ktére zostaly poniesione mimo uzyskania przez uzytkownika informacji o
mozliwos$ci ich wystgpienia.

W niektérych jurysdykcjach niemozliwe jest wylaczenie Iub ograniczenie
odpowiedzialnosci z tytutu szkéd pobocznych lub wynikowych, tak wiec powyzsze
ograniczenia lub wytgczenia odpowiedzialnosci moga nie stosowaé sie do danego
uzytkownika.

Niniejsza Ograniczona Gwarancja nadaje uzytkownikowi okreslone prawa, przy
czym w zaleznosci od danej jurysdykcji, uzytkownik moze posiada¢ rowniez dodatkowe
prawa.

OSWIADCZENIE O ZGODNOSCI Z WYMAGANIAMI FCC w
ZAKRESIE EMISJI ENERGII O CZESTOTLIWOSCI RADIOWEJ

Urzadzenie zostato przetestowane i stwierdzono jego zgodnos$¢ z zakresem
wymagan dla urzadzen cyfrowych Klasy B, zgodnie z Czescig 15 przepisow FCC.
Ograniczenia te stuzg zapewnieniu wtasciwej ochrony przed szkodliwymi zaktéceniami
w instalacjach mieszkalnych.

To urzadzenie moze generowaé, wykorzystywa¢ i emitowaé energie
o czestotliwosci radiowej. Jesli nie zostanie zamontowane i nie bedzie uzywane
zgodnie z instrukcjami, moze powodowac¢ szkodliwe zakidcenia tgcznosci radiowe;.
Jednakze nie mozemy daé gwarancji, ze zakiécenia nie wystapig w danej instalaciji
telewizyjnej (co mozna stwierdzi¢ poprzez wytgczenie i wtaczenie urzadzenia), zaleca
sie, aby uzytkownik prébowat wyeliminowac zaktdcenia poprzez zastosowanie jednego
lub Kilku z ponizszych $srodkow zaradczych:
B Zmiane orientacji i lokalizacji anteny odbiorczej.
B Zwiekszenie odlegtosci pomiedzy urzadzeniem a odbiornikiem.
B Podiagczenie urzadzenia do zrodta zasilania nalezagcego do obwodu innego
niz obwdéd odbiornika.
B Podtgczenia do urzadzenia ekranowanych kabli przytgczeniowych oraz
ekranowanych kabli zasilajgcych, ktére wchodzg w sktad zestawu, gdyz tylko
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one gwarantujg zgodnos¢ z odpowiednimi limitami zaktécen radiowych dla
tego urzadzenia.

B Jedli zakiocenia nie znikajg — skonsultowanie sie z do$wiadczonym
technikiem radiowo-telewizyjnym.

B Wszelkie zmiany Ilub modyfikacje niezatwierdzone wyraznie przez
producenta Ilub autoryzowane centrum serwisowe mogg skutkowaé
odebraniem uprawnien do korzystania z tego urzadzenia.

Niniejsze urzadzenie spetnia wymagania zgodnie z Czescig 15 przepiséw FCC.
Obstuga urzadzenia podlega nastepujgcym dwém warunkom: (1) niniejsze urzadzenie
nie moze powodowaé szkodliwego wptywu oraz (2) niniejsze urzadzenie musi by¢
podatne na wszelkie zaktdécenia w tym zakidcenia mogace powodowac niepozadane
dziatanie.
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KONTAKT Z PLUSTEK

Europa: Plustek Technology GmbH
An der Strusbek 60-62
22926 Ahrensburg
Germany

Tel.: +49 (0) 4102-8913-0

Fax: +49 (0) 4102-8913-500/508
E-mail: support@plustek.de
WWW: www.plustek.de

Ameryka Pin.: Plustek Technology Inc.
17517 Fabrica Way, Suite B
Cerritos, CA 90703
U.S.A.

Tel: +1 -714-670-7713
Fax: +1 -714-670-7756
E-mail: supportusa@plustek.com

Reszta swiata oprécz Plustek Inc.

Europy i Ameryki Pin.: 13F-1, No.3 (Building F), Yuan Qu Street
115 Nankang, Taipei
Taiwan

Tel: +886-2-2655 7866
Fax: +886-2-2655 7833
WWW: www.plustek.com

Nasza witryna internetowa, dostepna pod adresem
www.plustek.com
zawiera dodatkowe informacje o obstudze klienta.
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